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By Douglas J. Shinneman1, Justin L. Welty1, Robert S. Arkle1, David S. Pilliod1, Nancy F. Glenn2,  
Susan K. McIlroy1, and Anne S. Halford3

Abstract 
The Fuels Guide and Database (FGD) is intended to 

provide fuel loading and vegetation information for big 
sagebrush (Artemisia tridentata) ecological sites in the Morley 
Nelson Snake River Birds of Prey National Conservation 
Area (hereinafter the NCA) in southern Idaho. Sagebrush 
ecosystems in the NCA and throughout much of the Great 
Basin are highly influenced by non-native plants that alter 
successional trajectories and promote frequent wildfires, 
especially due to fine-fuel loadings that are highly variable 
over time and space. These dynamic fuel conditions can 
increase uncertainty when attempting to project fire risk and 
fire behavior. The FGD was developed to help quantify and 
assess these dynamic fuel loadings, and it provides access to 
fuels data across a range of conditions, from relatively intact 
sagebrush-bunchgrass communities to degraded communities 
dominated by nonnative annual grasses and forbs. The FGD 
can be queried for a variety of environmental conditions, and 
it provides tabular data, reports, and photographic records of 
fuels based on user queries. This report describes the FGD, 
including overall data content and data-collection methods, as 
well as instructions for installing and using the database. 

Introduction
The Fuels Guide and Database (FGD) for big sagebrush 

(Artemisia tridentata) ecological sites was developed as part of 
the project “Quantifying and predicting fuels and the effects of 
reduction treatments along successional and invasion gradients 
in sagebrush habitats” (Shinneman and others, 2015). The 
project was funded by the Joint Fire Science Program and 
the research was performed by the U.S. Geological Survey 
(USGS) and Boise State University researchers, in partnership 
with the Bureau of Land Management and the Idaho Army 
National Guard. Most of the research for the project focused 
on the Morley Nelson Snake River Birds of Prey National 
Conservation Area (NCA) in southern Idaho. Sagebrush 
shrublands in the NCA, and throughout much of the Great 
Basin and Snake River Plain ecoregions, are highly influenced 
by non-native plants that alter successional trajectories, 
suppress native species, and promote frequent wildfires. 
Fine-fuel loadings created by nonnative annual grasses and 
forbs can be highly variable through space and time, which 
can increase uncertainty when projecting fire risk and fire 
behavior. The overarching goal of the research project was to 
explore and develop different approaches to better quantify 
and assess these dynamic fuel loadings, as well as determine 
the effects of fuels manipulations in sagebrush habitats. The 
purpose of the database is to provide a tool that allows ready 
access to fuels data (in tabular, report, and photographic 
forms) across a range of conditions, from relatively intact 
sagebrush-bunchgrass communities to degraded communities 
dominated by nonnative annual grasses and forbs. This report 
describes the FGD and its content, including data-collection 
methods and instructions for installing and using the database. 

1U.S. Geological Survey.
2Boise State University.
3Bureau of Land Management.
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Collection Methods for Acquiring Fuels Data

Fuel loadings, plant composition, and plant structure 
were sampled from about 1,900 points (subplots) located 
within 211 1-hectare (ha) plots distributed across the NCA. 
To capture successional and invasion gradients caused 
by past wildfires and land use, 147 of the 1-ha plots were 
randomly stratified among burned and treated, burned and 
untreated, and unburned areas of the NCA. We also sampled 
sixty-four 1-ha plots that were part of an experimental 
treatment design (treated with mowing, herbicide, and 
seeding). Plots were sampled May–August during 2012–14, 
and 57 of the randomly distributed and 34 of the experimental 
plots were sampled during all 3 years to better understand 
the inter-annual variability of vegetation conditions and 
associated fuels. Within each 1-ha plot, nine subplots were 
placed on a 3 × 3 grid of evenly distributed points (each point 
25 meters [m] apart; fig. 1). At each of the nine points, basic 
environmental information was recorded and vegetation 
sampling techniques largely followed methods suggested by 
Pilliod and Arkle (2013), as follows: (1) the point-quarter 
method was used to sample density and cover of all shrub 
and bunchgrass species; (2) a 1 × 1-m quadrat was placed to 
determine plant species composition, measure plant height by 
functional group, and obtain plant biomass for fuel-loading 
estimates; and (3) a nadir photograph was taken from 2-m 
above each quadrat, from which percentage of cover of each 
species, litter, bare soil, and rock were later quantified in the 
laboratory using digital photo-grid software (SamplePoint; 
Booth and others, 2006). In each quadrat, six fuel types were 
collected: 10-hour down woody debris (DWD), 100-hour 
DWD, 1,000-hour DWD, live shrub, dead shrub, and 
herbaceous/litter (all live, dead standing, or litter herbaceous 
material, including 1-hour DWD). Fuel classes were separated 
into different bags in the field and oven-dried and weighed in 
the laboratory.

Fuels Guide and Database

The FGD is a tool designed to assist land managers in 
estimating fuel loads in a specific stand of vegetation, under 
conditions ranging from sagebrush-dominated to nonnative, 
annual grass/forb-dominated communities. Users can query 
the database based on vegetation cover, vegetation height, 
and specific environmental variables (for example elevation, 
precipitation, temperature, soil surface texture, and ecological 
site), and return fuel loading data that match the query 
parameters. The FGD also allows users to obtain data and 
view photographs by individual points or for entire 1-ha plots, 
and users can individually exclude points or plots to help 
identify areas that best match fuel conditions of interest (for 
example, current conditions based on cover or recent climate). 
Final results can be exported to Microsoft® Excel spreadsheet 
or summarized in Microsoft® Word reports that can be used to 
improve estimates of fuel loadings in the field. 
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Figure 1. A nadir photograph of the vegetation and 
a schematic diagram of a 1-hectare plot showing 
the distribution of the nine individual sampling points 
located within. At each point, a 12.5-meter radius 
area was used for point-quarter sampling of the 
larger plant species (for example, shrubs) and 1 × 
1-meter quadrat was placed for collection of biomass 
and for determining species composition, using field 
identification.
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Because fuels data were collected on the NCA, 
extrapolation of queried results should only be applied to 
the NCA and similar regional environments. However, there 
is potential for additional cover data, vegetation height 
data, and fuels data to be added to the FGD. To contribute 
data to the FGD, users can contact the USGS Forest and 
Rangeland Ecosystem Science Center. With additional 
input from sagebrush ecological sites in other landscapes, 
the FGD has the potential to be a powerful tool for land 
managers to quickly estimate fuel loadings throughout the 
sagebrush biome.

Installation Instructions

System Requirements

The FGD is currently distributed in a zipped format 
in a 64 gigabyte (GB) flash drive. The size of the FGD is 
approximately 35 GB; the large size is the result of storing 
many photographs. Please ensure that your computer has the 
appropriate space to handle this. The FGD requires Microsoft® 
Access, Excel, and Word 2013 run on a Windows 7 or higher 
operating system. Assistance may be available through local 
IT personnel, or FRESC personnel (fresc_outreach@usgs.gov) 
may be able to assist you in getting the tool operational.

Fuels Guide and Database Folder

The FGD includes several folders and files (fig. 2).
• Fuels_Project_Database (main folder)—Contains the 

Access database and all supplementary material.
 ° Fuels_Data (folder)—Contains all photographs, 

templates, and other data necessary to run the FGD.
 � Example_Outputs (folder)—Contains example 

Excel exports and Word reports that users 
can generate.

 � Fuel_Photos (folder)—Contains all above-
ground (nadir) and oblique photographs of the 
sampled points.

 � Input_Images (folder)—Contains images used 
to create the FGD, this document, and all other 
supplementary information related to the FGD.

 � Templates (folder)—Contains all Word and Excel 
templates necessary to generate the FGD reports.

 ° Fuels Project Database User Manual 20180806.docx 
(Word file)—this document.

 ° Fuels_Guide_and_Database_20180806.accdb 
(Access file)—The Access database used to analyze 
data.

 ° Fuels_Guide_and_Database_Metadata_20180731 
.xml (Metadata file)—The metadata used to describe 
the database, tables, and fields within the Fuels 
Guide and Database.

Figure 2. Contents of the Fuels_Project_Database folder.
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Installing the Fuels Guide and Database

1. Create a folder on your computer or server where the 
data will be stored.

2. Download the FGD from https://doi.org/10.5066/
F7PC31P4 (Welty and others, 2018) on to the computer 
and copy the Fuels_Guide_and_Database.zip folder 
to newly created folder (for example, My Documents 
folder: C:\Users\(username)\Documents\Fuels_
Database).

3. Right click on the Zip file and select “Extract All.” 
Follow the instructions to extract the contents to the 
current location.

4. Ensure all folders and files shown in figure 2 are present.
5. Open the Access file “Fuels_Project_Master_Beta.

accdb.”
a. When the database opens, users will need to 

enable certain security protocols depending on the 
computer’s security settings. The security protocols 
described here are for USGS computers. An 
additional step is listed for users who have additional 
security precautions enabled. However, additional or 
fewer security steps may be necessary to enable full 
functionality of the FGD. Users should consult their 
local IT specialist if they are not able to fully enable 
all security protocols. 
i. Depending on the user’s security settings, the 

“Enable Content” security warning will appear 
the first time the database is opened (fig. 3). 

ii. Users need to click on the “Query Data” button 
in the “Fuels Project Database” welcome 
window (fig. 3) to open the main query and 
reporting form. Users can then click on the 
“Enable Content” button to enable the database. 
This will reload the database and re-open the 
“Welcome” window.

iii. Users may see a security warning and be asked 
to make the file a “Trusted Document” (fig. 4). 
Click “Yes” to make the database a “Trusted 
Document.” This should enable database 
operation for most users. 

iv. Two additional steps can be taken if the 
“Database” form or buttons do not respond to 
commands or errors occur when attempting to 
export data or generate reports.

tac17-1142_fig 03

Figure 3. “Enable Content” security warning that 
appears when first opening the Fuels Project Database.

tac17-1142_fig 04

Figure 4. “Trusted Document” security window.

v. WARNING: This should only be used   
 as a last resort by your IT Specialist 
 If all previous security steps are 
 complete and the “Query Data” button| 
 or other buttons still will not function, go 
 to the ribbon and select File>Options>Trust 
 Center>Trust Center Settings…>Macro 
 Settings. Then click the radio button “Enable 
 all macros (not recommended; potentially 
 dangerous code can run).” 

https://doi.org/10.5066/F7PC31P4
https://doi.org/10.5066/F7PC31P4
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6. If the export or reporting functions fail to operate 
correctly, please ensure the appropriate “Reference 
Libraries” are checked (fig. 5). In the ribbon, go to 
Database Tools>Visual Basic. When the “Microsoft 
Visual Basic for Applications” window opens, in the 
menu bar click Tools>References. Ensure the references 
checked in figure 5 are checked in user copy of the FGD.

7. When the database is operational, set the location of the 
FGD photographs folder. This folder contains all the 
photographs for each plot and is used in the database 

and in report creation. From the FGD welcome window 
(fig. 3), select “Set the Fuels_Data Folder Location.” The 
folder location will default to “W:\Projects…” and must 
be updated. Double click on the text “W:\Projects…” 
(fig. 6) to open the folder dialog box. Navigate to the 
location of the Fuels_Data folder and select it. The 
database will automatically determine if the correct 
folder is selected. 

8. When the database is set up, users can begin to 
query data.

tac17-1142_fig 05

Figure 5. Fuels Project database references.

tac17-1142_fig 06

Figure 6. Window to set “Fuels_Data Folder Location” in Fuels Guide and Database.
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Using the Fuels Guide and Database
The FGD “Data Entry” form can be separated into three 

parts: (1) querying data, (2) analyzing results, and (3) creating 
reports. Users can access the “Data Entry” form by clicking 
on the “Query Data” button in the “Welcome” window (fig. 3) 
when the database is opened.

Query Data

Users can query the FGD in three ways: (1) species 
specific cover data, (2) functional group maximum height data, 
and (3) environmental variables (fig. 7). All fields in the query 
are optional. Users can select one or more query parameters 
from each type of selection or ignore one or more of the query 
types. Leaving every query selection blank will result in all 
data being returned. The command buttons are located in the 
top right corner of the query window (fig. 7). 
  Update the Query—After new query parameters are 

entered, the “Results” window (fig. 8) will disappear, 
indicating that new search parameters have been 
selected. When the new query variables are complete, 
click “Update the Query” to generate an updated 
“Results” window.

 � Reset the Query—Clicking this button will erase 
all current query data and reset the “Results” 
window to display all data.

 � Close Form—Clicking this button will close the 
“Query and Results” form and return the user to 
the “Welcome” form.

 Hint: When querying the data, start with one 
variable and, if desired, increase the number 
of variables one at a time and click “Update 
Query” after each selection. A single variable 
can potentially exclude large chunks of data in 
the results. Updating one search variable at a 
time allows the user to identify which variable is 
reducing the number of results returned.

Species Specific Cover Data
Use the “Species or Functional Group” drop down menu 

to select the species or functional group of interest (fig. 7). 
The variable includes the minimum and maximum cover data 
calculated for that variable. If a variable is selected, users must 
enter lower and upper cover bounds. Users can enter a lower 
or upper cover bound that is outside the range indicated in 
the “Species or Functional Group” selection without affecting 
the query. However, the only data that can be returned are 
data that are in the indicated variable range. Use the “Delete” 
button to remove a specific selection from the query. 

Functional Group Max Height Data
Users can select one or more function groups from 

the “Functional Group” drop down menu (fig. 7). As with 
cover data, the height range in centimeters (cm) is given. If 
a functional group height variable is selected, users must fill 
in the lower and upper max height ranges. Users also have 
the option of specifying whether metric (centimeters) or 
imperial (inches) units are being entered. Users can enter a 
lower and (or) upper height bound that is outside the range 
indicated in the “Functional Group Max Height” selection 
without affecting the query. However, the only data that can 
be returned are data that are in the indicated variable range. 
Use the “Delete” button to remove a specific selection from 
the query.

Environmental Variables
Specific environmental variables (for example, 100 year 

average hydrologic year precipitation, hydrologic water year 
sampled, elevation, and soil texture) for each point were 
calculated using various GIS layers. As with the other two 
search parameters, users can select one or more variable 
from the “Environmental Variables” drop down menu 
(fig. 7). The range is listed for precipitation, elevation, and 
temperature variables. If any of these variables are selected, 

tac17-1142_fig 07

Figure 7. Fuels Guide and Database search parameter and query window.
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users must enter lower and upper environmental bounds and 
indicate whether the values are metric (meter or centimeter) 
or imperial (foot or inch). Users can enter a lower or upper 
environmental bound that is outside the range indicated in 
the “Environmental Variables” selection without affecting 
the query. However, the only data that can be returned are 
data that are in the indicated variable range. Use the “Delete” 
button to remove a specific selection from the query. If 
“ecological site” or “surface texture” is selected, a “Soils 
Variable” window will appear instead of the usual lower and 
upper windows. Users then can select a specific ecological site 
or soil-surface texture variable to search based on selections in 
the drop down menu. 

 Note: If a user selects elevation, precipitation, 
or temperature variables and then selects an 
ecological site or soil surface texture (or the 
reverse), the upper and lower bounding boxes or 
the “Soils Variable” box from previously entered 
data will disappear. This is a function of how 
the database is designed. The data still exist in 
the selections that have disappeared and can be 
revealed by clicking on the desired “Environmental 
Variable.” Even if the search data are not properly 
displayed, they are still used to query the data. 

Analyze Results

After the query parameters are set and “Update the 
Query” is clicked, the results will appear in the pane below the 
query window (fig. 8). Users are presented with three levels of 
results: (1) “Plot Results,” (2) “Points Within Plots Results,” 
and (3) “All Point Results.” “Plot Results” are the average 
value of the nine points in the plot; the data are presented 
at this averaged level only. Because the data are averaged 
across nine points, it is possible that few or even none of the 
individual points meet the search criteria specified. However, 
the overall plot average still meets the criteria and is included 
in the results. “Points Within Plots Results” display data at the 
individual point level. However, only those points that meet 
the search criteria and are within plots that meet the search 
criteria are included. Finally, “All Point Results” displays 
individual points that meet the search criteria regardless of 
whether or not the plot met the search criteria. In the top right 
corner of the “Plot Results” window, users can see the totals 
returned for each of the three result windows.

tac17-1142_fig 08

Figure 8. “Plot Results” window in the Fuels Guide and Database.



8  Fuels Guide and Database for Intact and Invaded Big Sagebrush Ecological Sites—User Manual

Photographs
Both above ground (nadir) and oblique (landscape view) 

photographs for each point are included with the plot and 
point results (when available) in the sub-form in the right hand 
section of the “Plot Results” window (fig. 8). Photographs for 
each of the 9 points (as many as 18 photographs) are displayed 
at the plot level, whereas at most, 2 photographs can be 
displayed at the point level. To view thumbnail photographs 
for a particular plot or point, click the “Thumbnails” button 
in the plot or point row. Click on the photograph of interest 
to open it in a larger window. Photographs can be useful in 
sub-setting the query results.

Include in Average
Each of the plots or points that met the search criteria 

are displayed along with the summary data for those results 
(fig. 8). Users can exclude specific data by unchecking the 
“All Plots ‘Include in Average’ Summary” box. The summary 
results will update automatically after each box is unchecked. 
Users can view the photographs to assist in determining 
whether specific plots or points should be excluded from the 
results. Although the row will remain in a “Results” window 
if unchecked, it will not be used to calculate the average or 
included in any summary output or report.

Show All Years
Data for this project were collected from May to 

August 2012–14, with a subset of plots sampled all 3 years 
to better understand the inter-annual variability of vegetation 
conditions and associated fuels. Vegetation can vary through 
time such that a plot or point may meet the search criteria in 
only 1 or 2 of those years. The “Show All Years” checkbox 
is initially unchecked. If users wish to view the data for all 
3 years for a set of plots or points they can check the “Show 
All Years” checkbox and then select the “Show All Selected 
Years” command in the top left corner of the “Plot Results” 
window (fig. 8). A secondary “Results” window is displayed 
showing the data for all years the plots or points were 
monitored for the selected plots or points where the checkbox 
for “Show All Years” selected. Users have limited flexibility in 
this window, but many of the same photograph and reporting 
tools are available. To return to the main window, click the 
“Return to All Plots/Points” button in the top left corner of the 
child form that has opened (not pictured). All result windows 
contain essentially the same type of information and so all 
three types are described together. 

Create Reports

The FGD can generate multiple types of reports from 
high-level summaries to specific plot or point reports in Word® 
and Excel®. To see examples of reports that can be generated 
navigate to the “Fuels_Data\Example_Outputs” and view 
the documentation (fig. 2). Depending on the type of report 
required, users can select whether metric or imperial units are 
displayed and whether photographs should be included in the 
report. Word® reports include precipitation data and display 
results in both graphical and table formats.

 Note: These reports are built automatically. 
However, users must not change anything in the 
database or the Excel or Word files until the report 
is completely generated. Clicking in a report as 
it is being generated will result in an incorrect 
build and possible damage or corruption of the 
report. A pop-up window will appear when the 
report is completed. The location and name 
of the completed file will be indicated in this 
pop-up window.

Export “Include in Average” Data to  
Microsoft® Excel

This function exports the raw data into an Excel 
spreadsheet. The Excel spreadsheet contains multiple tabs that 
generally contains the following: (1) “Metadata” indicates 
whether metric or imperial units are used, (2) “Search 
Criteria” indicates the search criteria used to generate the 
results, (3) “Point Cover Data” includes the vegetation cover 
at the specific points, (4) “Point Fuels Data” indicates the 
fuels data calculated at each point, (5) “Plot Cover Data” is 
only displayed for a plot level export and contains the cover 
data summarized at the plot level, (6) “Plot Fuels Data” is 
only displayed for a plot level export and contains the fuels 
data summarized at the plot level, and (7) “Average Plot/Point 
Fuels Data” contains the summarized fuels data across all 
selected points or plots. 

Point Summary
This is the simplest report and includes data and 

photographs for the individual point selected. This report is 
available only for the point level results.
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Plot Summary
Plot summaries are available at both the plot and point 

levels. This report summarizes the plot level data for only the 
selected plot across all years the plot was monitored. Users 
have the option of including the photographs in this report.

All Plots or Points ‘Include in Average’ 
Summary by Year

Summaries by year are available at both the plot and 
point levels. In the “Show All Selected Years” window, 
this report is titled “All Plots” or “All Points Summary by 
Year.” The report displays the summary data for fuel type 
and cover data by year for all the plots/points selected. The 
number of plots/points can vary by year because not all plots/
points may meet the criteria every year. This type of report 
is useful for showing how the vegetation within plots/points 
that meet the criteria can vary through time, often in response 
to precipitation.

All Plots or Points ‘Include in Average’ Summary
In the “Show All Selected Years” window, selected 

reports are titled “All Plots” or “All Points” Summary. These 
reports display the summary data for both fuel type and cover 
data summarized across years. These reports are useful for 
estimating fuel loadings based on current cover conditions.

References Cited

Booth, D.T., Cox, S.E., and Berryman, R.D., 2006, 
Point sampling digital imagery with ‘Samplepoint’: 
Environmental Monitoring and Assessment, v. 123, no. 1, 
p. 97–108.

Pilliod, D.S., and Arkle, R.S., 2013, Performance of 
quantitative vegetation sampling methods across gradients 
of cover in Great Basin plant communities: Rangeland 
Ecology and Management, v. 66, no. 6, p. 634–647, 
doi:10.2111/REM-D-13-00063.1. 

Shinneman, D.J., Pilliod, D.S., Arkle, R.S., and Glenn, N.F., 
2015, Quantifying and predicting fuels and the effects 
of reduction treatments along successional and invasion 
gradients in sagebrush habitats: Joint Fire Science Program, 
Final Report, JFSP Project 11-1-2-30, 44 p.

Welty, J.L., Shinneman, D.J., Arkle, R.S., Pilliod, D.S., Glenn, 
N.F., McIlroy, S.K., and Halford, A.S., 2018, Fuels database 
for intact and invaded big sagebrush (Artemisia tridentata) 
ecological sites: U.S. Geological Survey data release, 
https://doi.org/10.5066/F7PC31P4.





Publishing support provided by the U.S. Geological Survey
Science Publishing Network, Tacoma Publishing Service Center

For more information concerning the research in this report, contact the 
Director, Forest and Rangeland Ecosystem Science Center 
U.S. Geological Survey 
777 NW 9th St., Suite 400 
Corvallis, Oregon 97330 
https://www.usgs.gov/centers/fresc

https://www.usgs.gov/centers/fresc


Shinnem
an and others—

Fuels Guide and Database for Intact and Invaded Big Sagebrush Ecological Sites—
User M

anual—
Data Series 1048

ISSN 2327-638X (online)
https://doi.org/10.3133/ds1048 


	Fuels Guide and Database for Intact and Invaded Big Sagebrush (Artemisia tridentata) Ecological Sites--User Manual
	Contents
	Figures
	Conversion Factors
	Abstract 
	Introduction
	Collection Methods for Acquiring Fuels Data
	Fuels Guide and Database

	Installation Instructions
	System Requirements
	Fuels Guide and Database Folder
	Installing the Fuels Guide and Database

	Using the Fuels Guide and Database
	Query Data
	Species Specific Cover Data
	Functional Group Max Height Data
	Environmental Variables

	Analyze Results
	Photographs
	Include in Average
	Show All Years

	Create Reports
	Export “Include in Average” Data to 
Microsoft® Excel
	Point Summary
	Plot Summary
	All Plots or Points ‘Include in Average’ Summary by Year
	All Plots or Points ‘Include in Average’ Summary


	References Cited

